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Sap crystal reports 2013 trial

Go to content Use your small and medium-sized business to convert all data into interactive, usable information— easy and fast. Download your 30-day trial today. Connect to virtually any data source, including databases, spreadsheets, enterprise systems, and cloud services Create custom, visually stunning reports Personalize reports
with your business users' preferred language and format Create your unique SAP ID by starting a trial version, and use the same ID for your digital purchase. Back to the top Go to content Explore how the SAP solution satisfies your business needs and delivers as promised before you buy it. Access comprehensive, up-to-date online
training and activation tools for the SAP software array. Discover, download and purchase SAP solutions and services from SAP and our partner ecosystem. Build your skills with comprehensive, up-to-date online learning content, social learning, and peer-to-peer collaboration — whenever and where it's convenient. Support targeted
learning, improve employee experience, and protect your brand by quickly implementing web-based training for a customer-oriented company. Discover, try and purchase SAP solutions and services from SAP, including analytics software, mobile apps, and cloud solutions. Visit our digital market to explore, test and purchase trusted third-
party solutions for your SAP software environment. Back to top Switch to content facts What is SAP Crystal Solutions? Products that are branded SAP Crystal are software tools used for data analysis and data reporting. Current products include: Crystal Reports, Crystal Server, Crystal Reports Visual Studio, Crystal Reports for Eclipse
and Crystal Reports Viewer. What do these products do? SAP Crystal Reports allows the report designer to implement data from different sources to create a document that formats the data of its choice, such as invoice, sales, or activity report, marketing letter, or some analytical way. SAP Crystal Server provides a platform through
which you can share documents (such as SAP Crystal Reports files) with end users. With Crystal Server, you can schedule messages to be ejected as PDF email attachments or securely access reports and refresh data by entering parameters using a browser or mobile app. SAP Crystal Reports Viewer is a free desktop application
(Windows or Mac) that allows recipients of Crystal Reports files (.rpt file extension) to open a document and interact with data stored with a file, including search, digging, printing and exporting, but not refreshing. SAP Crystal Dashboard design is included in the Crystal Server 2016 named end user license package. It is a designer who
creates interactive data which you can embed in webpages, PDF, Word, and Documents. These documents can be separate, linked to data sources, or embedded in a Crystal Reports file. How does SAP Crystal Reports and SAP Crystal Server work together? Start with Crystal Reports to create a report. Crystal Server distributes reports
by pressing messages, such as a scheduled email attachment. Crystal Server also provides a portal for users to access content securely through a browser or mobile app to view, enter parameters, refresh, and print or export a report. WHAT CAN SAP Crystal Reports and SAP Crystal Server DO? If you need to understand your business;
if you need data for the action plan; if you want to provide information on an aspect of your business, then the analytical capabilities of Crystal Reports will be valuable to you. After you create a report that is ready to print, others may want to use the report as well. Crystal Server provides the ability to distribute the report to end users. Who
usually uses SAP Crystal Solutions? People who use Crystal Reports are usually the ones who use data in a lot of their daily role, such as database administrators, IT, finance, accounting and business energy users. People who log on to the portal provided by Crystal Server to access pre-build content are typically end users, business
users, and management; in other words, consumers with reports who want answers to a business question have already been asked on their behalf (those who created the report with Crystal Reports). Licensing What are the different licenses? SAP Crystal Reports 2016, Named User License: SAP Crystal Reports is sold on the basis of a
named user license; each person using the software requires one unique license. As the License holder of the Named User, this person may install the software on any number of computers (including simultaneously) for any number of times for their exclusive use with a valid, non-experiant license code; The named user license cannot
be shared with another person. SAP Crystal Server 2016 licensing. Crystal Server has two types of license: Named User License (NUL) and Concurrent Access License (CAL). Licensing determines access to the interfaces that share documents that are available for viewing: BI Launchpad, Crystal 1, NUL includes a single license for
Crystal Reports 2016. Note: The CAL includes publishing, a feature in which the report data is unique to each recipient (such as invoices and statements). Publishing to an unlimited number of unique recipients is included in crystal server 2016 CALs. What is included in the Crystal Server 1 NUL license? The SAP Crystal Server 1 NUL
license includes 1 named SAP Crystal Server 2016 user license and 1 SAP Crystal Reports 2016 license. It also comes with support for mobile access to iOS devices. 1 named user license (1 NUL) allows you to use only one, specific individual user. What are crystal server 2016 licensing and maximum? SAP crystal crystal 2016
deployments require NUL 1 at least. Cal license is purchased separately from NUL, it is added to nul deployment. SAP Crystal Server 2016 NUL can be added in total up to a maximum of 100 NUL. SAP Crystal Server 2016 CAL is sold insularly and can be increased to 50 CALs. Product versions How are sap crystal reports versions
named? SAP Crystal Reports includes version numbering with product name by SAP Crystal Reports Xi (version 11). Subsequent versions include the year of release with the product name; SAP Crystal Reports 2008 is version 12, SAP Crystal Reports 2011 version 14.0, SAP Crystal Reports 2013 is version 14.1 and SAP Crystal
Reports 2016 version is 14.2. All versions of SAP Crystal Reports designer are Developer Editions. The last version of which was Standard, Professional and Developer editions was SAP Crystal Reports Xi. Standard and professional expenses were eventually discontinued after the release of SAP Crystal Reports 2011. The SAP Crystal
Reports Xi Developer edition is still available and does everything that Standard and Pro could do – and more. What is SAP Crystal Reports version 13? SAP Crystal Reports, a version of Visual Studio and SAP Crystal Reports, the developer version of Eclipse is part of the Crystal Reports product family version 13. These are tools
available to developers to create basic reports and embed the Crystal Reports program to run the report files (in.rpt format) in the application they developed using the Crystal Reports Software Development Kit (SDK). Version numbering for these free downloads of the SDK and Runtime is version 13. Languages Which languages are
supported? The SAP Crystal Reports 2016 user interface is localized in the following languages: English, French, German, Japanese, Spanish, Simplified Chinese, Italian, Dutch, Russian, Korean, Traditional Chinese, Portuguese, Swedish, Polish, Danish, Norwegian, Finnish, Thai, Czech, Hungarian, Slovak, Turkish, Romanian,
Slovenian. Arabic, Hebrew, Ukrainian, Kazakh are only supported in SAP Crystal Reports DHTML Viewer using Internet Explorer and Firefox. Compatibility Are SAP Crystal Reports Backward Compatible? Yes. You can open reports created using previous versions, such as SAP Crystal Reports 9 and later, including the highest: SAP
Crystal Reports 2016. Any changes or new messages that you create with SAP Crystal Reports 2016 can only be saved as version 14.2 of the .rpt file. Can I use the old message with SAP Crystal Server 2016? We recommend that you migrate the message to the same version as SAP Crystal Server. Do this by opening the .rpt file with
SAP Crystal Reports 2016, then save. Report will be saved as version 14.2 . You may want to Save As and rename the copy to archive the document in the original, earlier version until all content has been migrated to your satisfaction. Can I use SAP Crystal Reports 2016 to edit a message that runs through a legacy application? If your
uses SAP Crystal Reports runtime engine version 13, then you can use SAP Crystal Reports 2016 for reporting. If your application uses a previous version of the sap crystal reports runtime, we recommend that you use the same version of SAP Crystal Reports as the designer to ensure compatibility. It is best to check with the developer
application for your recommendation. What are the hardware specifications for SAP Crystal Server 2016? Minimum server hardware requirements: processor: 2.0 GHz dual-core 64-bit CPU memory: 16 GB RAM Memory Space - Default English installation/11 GB All Languages/30 GB Operating System Requirements: Windows Server:
2019, 2016, 2012 R2, 2008 R2 Linux: SUSE x86_64 SLES 11, 12, Red Hat x86_64 EL 6, 7, Oracle Linux 7.2, 7.5 Minimum system requirements: browsers: IE 10, 11, Edge HTML 14.1, 15.15, 16.x, 17.x, Firefox ESR 45.x, 52.x, 60.x, Safari 7-12, Google Chrome For more information see bi platform 4.2 supported platforms, Crystal Server
2016 is based on. Support levels Where can I get support for my product? If you have purchased an SAP Crystal Server and have a maintenance contract, you can access the SAP services market to create a support ticket so that the engineer can work with you to resolve the problem. Also available to customers who stay in the SAP
services market, is ask expert peer up to 20 questions per month can ask 1:1 consultation with SAP partner at no additional cost. You can access free support through the SAP Community. Can I buy support for a specific case? If customers have a technical problem, they can use this paid resource: SAP Crystal Single Case. The
purchase of Sap Crystal Single Case gives you access to English for our customer support engineers through the online ticketing process and is valid for one full year from your purchase date, except for the weekend, for one problem. There is no software to download or install. You can buy SAP Crystal case support through an online
store (supported versions only) in North America (USD), UK (GBP), Germany (EUR), France (EUR), APJ. When does support for different versions stop? SAP Crystal Reports 2016: 31 December 2020 SAP Crystal Reports 2013: 31 December 2018 SAP Crystal Reports 2011: 31 December 2015 SAP Crystal Reports 2008 : 31 December
2015 SAP Crystal Reports Xi R2 (2005): 30 June 2011 SAP Crystal Solutions for Developers Purchasing SAP Crystal Solutions What is the difference between a trial version and what I could install in production? In addition to the price, the time for which the software can be used is the only functional difference between free trial and paid
production facilities; for temporary use with or without a test facility. There are no restrictions on functionality, and using SAP Crystal Reports software with a temporary or production license, is not used. Can I convert to convert production facility? Yes, you already have the full software installed, you just need to unlock its continuous use
by removing the temporary key and replacing it with your non-emelable production code on the Help &gt; License Manager menu. What discounts are available? The amount has a discount based on the quantity of items purchased for each transaction. For example, if you buy 2 sap crystal reports 2016 license quantity through sap store,
a volume discount of 10% is applied at the cash time. Sap Crystal Reports 2016 purchase as an upgrade from sap Crystal Reports previous version is a discount (see next section). Which versions are eligible for purchase with an upgrade discount? You are eligible to purchase an SAP Crystal Reports 2016 (version 14.2) license with
upgrade discount if you have named a user license holder in one of the following previous versions of SAP Crystal Reports (see list below): SAP Crystal Reports 2013 (version 14.1) SAP Crystal Reports 2011 (version 14.0) Crystal Reports 2008 (version 12) SAP Crystal Reports Xi (version 11.0) and/or SAP Crystal Reports Xi R2 (version
11.5) SAP Crystal Reports 10 SAP Crystal Reports 9 SAP Crystal Reports 8 Crystal Reports 8 Crystal Reports 7 SAP Crystal Reports, version of Visual Studio 2008 (version 10.5) in SAP Crystal Reports, Visual Studio 2005 Version (Version 10.2) SAP Crystal Reports, Version of Visual Studio 2003 (version 9.1) SAP Crystal Reports,
Version Eclipse (with Registered Copies) with SAP Crystal Reports 2016 , can I use my existing messages from an earlier version of SAP Crystal Reports? yes, i'm sure. Reporting files created with SAP Crystal Reports version 9 and later should work with SAP Crystal Reports 2016. The process of migrating an earlier version report file
(.rpt) is to open a file with SAP Crystal Reports 2016 (choose File&gt;Open instead of double-clicking the file in Windows Explorer), then Save. The message will be saved as an .rpt file in SAP Crystal Reports 2016 (version 14.2). Cannot Save As with SAP Crystal Reports 2016 to save a different version than 14.2. Consider renaming the
file before saving it with SAP Crystal Reports 2016 to save the original if an earlier version is still required. What about upgrading to SAP for Crystal Server 2016 deployment without maintenance? For customers that have an earlier version of SAP Crystal Server not maintenance, sap crystal server 2016 1 Named User License has a new
license type and no upgrade path from previous named user license deployment. SAP Crystal Server 2016 5 concurrent access license does not have upgrade options; purchase of a new licence. Is it possible to amend the end-user license agreement? Installing and using SAP Crystal solutions Do you have problems installing software?
See the following items for details: Installing and setting up video Crystal Reports Installation instructions (simplified) If your download files in the files instructions, please start a chat with the SAP store or contact your supplier. If you're still having problems, please follow this guide: If you still encounter an INS00140 error following the
instructions above, this may be a conflict with third-party software that uses the same .dll name in the case of keycode decryption. Please do the following: Search your computer for all local Cryptocme2.dll cases (to see if what other software it uses) Rename *.dll extension for identified cryptokme2.dll files using OLD (for example) Reboot
machine Log in as Admin account Run installation again and it should pass the keycode check Rename cryptocme2.old files back to cryptocme2.dll How do I get the license key from the local machine? First, open the program and go to the Help menu and select License Manager You will see part of the license key, write down its first few
characters Next, start the registry editor by going to the Windows Start menu and selecting Run (or hold the Windows key and press R) In the new open window, type regedit and click OK When RegEdit is open : Click HKEY_LOCAL_MACHINE, press Ctrl + F (find) Enter a partial license that you copied from the license manager and
choose find the next Search will find the key. The code will be displayed when the installation date is added to the end. The code starts with the 5 characters you type and ends with the last two displayed in The License Manager. The registry editor path could be:
Computer&gt;HKEY_LOCAL_MACHINE&gt;SOFTWARE&gt;WOW6432Node&gt;SAP BusinessObjects&gt;Suite Xi 4.0&gt;Crystal Reports&gt; Keycodes&gt; CR Dev (ignore semicolons and numbers – this is a date setup) What if I have lost my registration number? In SAP Crystal Reports Xi, SAP Crystal Reports Xi R2 and SAP Crystal
Reports 2008, please use the general registration number 8886909502 when prompted for registration number. Do you get an INS00140 Error? Please do as follows: Search your computer for all local instances of Cryptocme2.dll (to see what other software can use) Rename the *.dll extension to the identified cryptocme2.dll files using *.
OLD (for example) Reboot machine Log on as Admin account Rerun installation and must pass key code check Rename cryptocme2.old files back to cryptocme2.dll Is it possible to edit SAP Crystal Reports generated SQL? When you create a query, SAP Crystal Reports automatically generates SQL (structured query language) that
matches the query and saves it as an SAP Crystal SQL command object. An Sql statement generated by crystal reports cannot be edited, but can be viewed. In the Query Panel, click View SQL. The SQL DIALOG BOX appears. It contains the SQL that is creating the query. Use this option if you want to test SQL when you create a query.
Whether you can use your SQL You can create your own SQL query by using the SAP Crystal sql designer tool. There you Insert your SQL statement. It will be saved as a .qry file. To use it in a report, select the Crystal SQL Statement button instead of the Database button. To maintain optimal report processing speed, do not use
formulas (crystal or basic syntax) in record selection formulas. Instead, replace the original formula with an equivalent SQL expression field, and then include the SQL expression field in the record selection formula. Back to top
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